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Chapter 1

Introduction

1.1 Purpose

The Observing Tool provides a comprehensive set of interfaces, forms and tools to define observing proposals
and to prepare observations with the Atacama Large Millimeter/submillimeter Array. The full description of the
Observing Tool and how to prepare the observations using the OT can be found in the ALMA OT User Manual.

In the OT the user will be confronted with various fields and interfaces with a large number of menus, input
fields and buttons that need to be completed and/or used for defining a proposal or observing project. A major
fraction are mentioned and briefly described in the various chapters of the OT User Manual. However, for
readability reasons more comprehensive descriptions of the OT fields and menus were not included.

This ALMA OT Reference Manual contains these descriptions and definitions. The information is basically
arranged in the same order as they are presented in the User Manual and as the user will most likely use the
OT. As some of the forms contain many fields, they are split into subsections as they appear as panels in the
forms. For all forms, the descriptions of the fields are provided starting at the top of the forms.

Chapter 2 provides descriptions of the main OT menu and its tool bar at the top as well as some additional
information about the OT graphical interface. Chapter 3 describes the buttons of the Tools and Simulators,
currently the Exposure Time Calculator and the Calibration Selection Tools. In Chapter 5, reference information
is provided for the parameters required for completing Science Goals for Phase 1 proposals and Phase 2 programs.
Similarly, Chapter 6 provides references for all Scheduling Block parameters for defining Phase 2 programs. Note
that defining Phase 2 Scheduling Blocks requires a solid knowledge of interferometry in general and ALMA in
particular. Descriptions for the Visual Spatial and the Visual Spectral Editors are provided in Chapter 7.1 and
7.2.

To provide a good overview of “what is where”, all descriptions are accompanied by one or more figures that
show the corresponding (part of the) form, menu, interface or tool bar.

1.2 Release Information

This version of the manual is consistent with the OT Release for Cycle 0 of Early Science (March 2011).

Although you do not need to register with ALMA in order to download the OT, you will need to be regis-
tered to submit a proposal. Registration and OT download can be accomplished at the ALMA Science Portal:

http://www.almascience.org
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1.3 Credits and Acknowledgments

The ALMA OT is a software product of the ALMA Observation Preparation Software Team and is developed
on the basis of the ALMA Science Software Requirements (SSR) and the ALMA High Level Analysis (HLA)
documents, produced by the respective groups. The OT software group acknowledges the valuable inputs of
these groups during the development phases of the OT. Also, the OT software groups thank the OT external
community testing group for their testing efforts of the various versions of the OT.
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Chapter 2

Overview of the Observing Tool

The OT main GUI contains three major components: the Menu at the top, the Toolbar below this that contains
the most frequently used functions in the Menu and below this, a number of different panes that show information
about the project and which allow various parameters of a proposal/observing program to be defined. These
panes take up most of the OT’s screen space. An example of the OT’s appearance is shown in Figure 2.1. These
components are now briefly described.

Figure 2.1: The Observing Tool main GUI.

2.1 Menu Bar

The Menu Bar gives access to a variety of OT functions and tools. Below follow the descriptions of the available
choices:

Figure 2.2: The Menu Bar of the Observing Tool main GUI.
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2.1.1 File

The File menu item contains submenus for managing projects (project validation, open, save, retrieve, import
and export, etc.), for handling standard or project libraries, and to exit the OT.

• New Proposal: Create a new observing proposal for Phase 1.

• New Program: Create a new observing program for Phase 2. This is reserved for privileged users only.

• Open Project: Open a project that has previously been saved to disk. If the location of a project is not
known, the Project Finder can be used to search a disk. A project can also be retrieved from the ALMA
Archive.

• Save: Save a project to the disk without prompting for a new filename.

• Save As: Save a project to the disk and allow a new filename to be entered.

• Show ALMA Template Library: Open the ALMA Template Library in the Project Structure pane.

• Use Project as Template: Open an ALMA project from disk and show it in read-only mode.

• Validate: Validate the project currently loaded in the OT.

• Submit Project: Submit the project to the ALMA Archive for validation and review.

• Submit As New: Submit the current project to the ALMA Archive as a new project. The project will
obtain a (new) ID number. This is reserved for privileged users only.

• Preferences: Set the OT Preferences.

• Quit: Exit the OT.

2.1.2 Edit

The Edit menu item is used for project editing functions (cut, paste, delete, rename) and for adding/deleting
project components like Science Goals or Sscheduling Block components. Note that the availability of the function
depends on which component of a project has been selected.

• Cut: Cut a selected Science Goal or Scheduling Block component.

• Copy: Copy a selected Science Goal or Scheduling Block component.

• Paste: Paste a project item from the clipboard.

• Rename: Rename a Science Goal, ObsUnitSet or Scheduling Block.

• New Phase 1 Science Goal: Create a new Phase 1 Science Goal. This is only available when in the
Proposal or Planned Observing nodes.

• New Phase 2 Science Goal: Create a new Phase 2 Science Goal. This is reserved for privileged users
only.

• Add Observatory Setup: Create a Science Goal for observatory-specific observations. Available choices
are: Holography Setup, Astro-Holography Setup, Optical Pointing Science Goal, Radiometric Pointing
Goal, Baseline Calibration Goal and Calibrator Survey Goal. This is reserved for privileged users only.

• Add...: This allows you to add one of many components (ObsUnitSet, Scheduling Block, Target, etc.) to
a Phase 2 project.

• Attach/Detach...: Attach/detach a Scheduling Block field source, instrument setup or observing param-
eter to/from a Target. This is reserved for privileged users only.
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• Delete: Delete a selected Science Goal or Scheduling Block item.

• Suspend: Suspend the observation of this Scheduling Block. This is reserved for privileged users only.

• Resume: Resume observing the Scheduling Block. This is reserved for privileged users only.

• Mark as Repaired: Mark the Scheduling Block as repaired. This is reserved for privileged users only.

• Terminate: Terminate further observation of the Scheduling Block. This is reserved for privileged users
only.

2.1.3 View

• Feedback: Display or hide the Feedback panel.

• Overview: Display or hide the Overview panel.

• Show ALMA Template Library: This displays the Template Library in the Project Structure pane.

2.1.4 Tools

• ALMA Calibration Selection Tool...: This tool allows you to investigate which calibrators are available
based on various selection criteria.

• ALMA LO Configuration Tool...: This tool enables the details of the local oscillator setup to be
experimented with. It is most useful for advanced users.

• ALMA Calibration Time Estimate Tool...: The OT calculates how long calibrators must be observed
for based on the information entered into the Science Goals. This tool allows you to experiment with the
various parameters that go into the equations.

• Sensitivity Calculator...: The ALMA Sensitivity Calculator allows you to calculate required observing
times for a given sensitivity (and vice versa) based on various criteria.

• Generate SBs from the Selected Goal: Automatically generate one or more Scheduling Blocks for the
selected Phase 1 or Phase 2 Science Goal.

• Generate Phase 1 SBs from all the Science Goals: This automatically generates SBs from all of the
Phase 1 Science Goals. It is reserved for privileged users only.

• Generate Phase 2 SBs from all the Science Goals: Create one or more Scheduling Blocks from all of
the Phase 2 Science Goals. This option becomes available if your proposal has been approved and retrieved
from the archive.

• Show Printable Summary of Science Goal: Make a summary PDF file of the proposal. This can be
printed.

• Generate a PDF of Whole Proposal: This will save the PDF of the proposal to disk.

• Disable Edit Protect: If Enable OUS Write Protection has been selected in File → Preferences →
Advanced, this option allows it to be easily deselected. It is reserved for privileged users only.

2.1.5 Search

The Search menu item enables you to move between the problems reported in the Feedback pane (see below).
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2.1.6 Debug

The Debug menu item enables/disables debug facilities. It is only displayed when Debug is activated via Prefer-
ences → Advanced. This option is for developers only.

2.1.7 Help

The Help menu item gives access to the User Manual and Reference Manual as well as general information about
the OT (credits, version number, etc.).

2.2 Toolbar

The Toolbar contains buttons for executing frequently-used OT functions and tools. Not all the buttons are
always active, this depending on the user’s privileges and the current choice of node in the Project Tree. The
following buttons are included:

Figure 2.3: The Toolbar of the Observing Tool.

• New Proposal (Phase 1): Create a new observing proposal for Phase 1.

• New Observing Program (Phase 2): Create a new observing program for Phase 2. This is reserved
for privileged users.

• Open Project from ALMA Archive: Retrieve a project from the ALMA Archive.

• Show ALMA Template Library: Open the ALMA Template Library in the Project Structure pane.

• Open Project from Disk: Open a project that has previously been saved to disk.

• Save Project to Disk: Save a project to disk without prompting for a new filename.

• New Phase 1 Science Goal: Create a new Phase 1 Science Goal. This is only available when in the
Proposal or Planned Observing nodes of the Project Tree.

• New Phase 2 Science Goal: Create a new Phase 2 Science Goal. This is reserved for privileged users
only.

• Generate SBs from the Selected Goal: Automatically generate one or more Scheduling Blocks for the
selected Phase 1 or Phase 2 Science Goal.

• Add an ObsUnitSet: Add an ObsUnitSet to a Phase 2 project. A Special Observing Program folder is
also created which contains the create ObsUnitSet.

• Add a Scheduling Block: Add a Scheduling Block to an ObsUnitSet.

• Sensitivity Calculator: Start the ALMA Sensitivity Calculator.

• ALMA Calibrator Selection Tool: Start the Calibrator Selection GUI.

• Validate: Validate the current project.

• Go to previous Problem: Go to the previous problem that was found by the validator and displayed in
the Feedback pane.

• Go to next Problem: Go to the next problem that was found by the validator and displayed in the
Feedback pane.
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• Contextual Help: Get help for the topic under the cursor when clicking somewhere in the OT’s main
GUI.

2.3 Panes

2.3.1 Project Structure

The Project Structure pane shows the Project Tree, a collection of folders and subfolders that contain all
the information required for the observatory to interpret your proposal and/or observing requirements. The
visualisation of the project tree depends on whether Phase 1 (Proposal) or Phase 2 (Program) is selected using
the tabs at the top (or bottom if you have changed your view preferences in File → Preferences) of the pane.
Both have a folder at the top with the project’s title.

Proposal

When selecting the Proposal tab, the Phase 1 Project Tree becomes visible. The Proposal node contains all the
information needed for completing the proposal’s Science Goals. The Science Goals are specified in the folder
Planned Observing, which contains the following forms:

• General: This form allows a name and description of the Science Goal to be entered.

• Field Setup: This is used to specify source parameters such as the coordinates and velocity.

• Spectral Setup: The details of the frequency setup are defined here.

• Calibration Setup: Here the user can choose between system-selected calibrators (recommended) or
define his own calibration sources.

• Control and Performance: This form collects basic science parameters that will be used to define the
antenna configurations and time constraints.

Program

When selecting the Program tab, the Project Tree for a Phase 2 program becomes visible. This is used to
provide Phase 2 details, usually in terms of Science Goals from which ObsUnitSets and Scheduling Blocks (SBs)
can be automatically generated. Alternatively, advanced users can manually create the ObsUnitSets and SBs
themselves. The Phase 2 Science Goal forms are located under the Science Plan node and are identical to the
forms for Phase 1 (see above). An observing program contains the following:

• ObsUnitSet (OUS): This contains the Scheduling Blocks and allows the user to specify the dependence
rules of the SBs within. ObsUnitSets can be nested although there are restrictions on how this can be
done.

• Scheduling Block (SB): This is the key executable unit of a project and contains all information necessary
to execute an observation. A SB can be repeated several times to achieve the desired sensitivity or to reach
the maximum allocated time. Each SB is built up from a collection of Targets.

• Targets: A Target defines an individual observation of a source. It consists of a field source definition,
an instrument setup and a set of observing parameters. These are in turn contained within the Resources
node.

• Resources: This contains the definitions of the source, spectral setup and observing parameters that are
required to define a Target.

– Field Source: This defines the details of the source to be observed.
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– Instrument Setup: This specifies the frequency and correlator setup.

– Observing Parameters: This contains the details (e.g. integration and cycle times) for various
types of observation (e.g. science, calibration, pointing).

Template Library

The lower section of the Project Structure pane can be used to either load the ALMA Template Library or to
display a local ALMA project (read-only). Parts of the templates can be copied and used for an active project.

2.3.2 Editors

The Editors pane contains three views, each of which is selectable via a tab. The name of the tab, and the ability
to select it, changes depending on which node in the Project Tree has been chosen. The three tabs are:

• Spectral: This enables the Visual Spectral Editor to graphically visualise the frequency information for
the receiver bands and spectral windows.

• Spatial: This enables the Visual Spatial Editor to display an image of a source, either from a choice of
image servers or from a local FITS file. This is useful for defining where the telescope should point.

• Forms: The third tab displays the form corresponding to the node that has been selected in the project
tree; the name of the tab reflects this choice. Whilst the forms for a Science Goal are relatively simple, the
forms for SBs are much more complex. Note that the label of the tab depends on the node that has been
selected in the Project Tree.

2.3.3 Feedback

The Feedback pane reports errors and warnings found when running the validator. The Feedback pane has three
tabs: Log, Problems and Information.

• Problems: This shows a table of the errors and offers the possibility to jump directly to the erroneous
item in the project tree. This is the most useful tab for the general user.

• Information: This gives a one-line summary of the validation results, but this can be opened to reveal
more detailed information on each error.

• Log: Yet another view of the errors.

2.3.4 Overview

This pane displays an overview of the main tasks that need to be carried out to create and submit a proposal,
as well as the retrieval of the approved program and generation of SBs (Phase 2). It aims to provide a general
overview and brief contextual help. It is aimed at novice users; more experienced users can shrink the panel.

Figure 2.4: The Overview Panel.
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Chapter 3

Tools and Simulators

The OT is equipped with a number of tools:

• Sensitivity Calculator

• Spectral Line Selection Tool

• Calibration Selection Tool

• Calibration Time Estimate Tool

• LO Configuration Tool

Note that in the Sensitivity Calculator and Calibration Selection Tool, some required information (e.g. target
position) will be filled in if the tool is started in a context where they can be determined.

3.1 Calibrator Selection Tool

The tool allows the user to find calibrators based on various search criteria, including distance from a sky position
and flux density. This can only be used when constructing a Scheduling Block.

• Cone Search RA: The centre Right Ascension coordinate of the cone search.

• Cone Search Dec: The center Declination coordinate of the cone search.

• Search Radius: The search radius in degrees around the cone centre coordinates – 0.0 will use the whole
sky.

• Flux Min: Minimum flux for the search.

• Flux Max: Maximum flux for the search.

• Frequency Min: Minimum frequency for the search.

• Frequency Max: Maximum frequency for the search.

• Last Observed Min: Minimum time since the last observation.

• Last Observed Max: Maximum time since the last observation.

• Max Results: Maximum number of sources to return (maximum 100).

• Submit Query: Find the calibrator using the given constraints.
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Figure 3.1: The Calibrator Selection Tool.

• Catalogue Selection: Select either an internal or online catalogue.

• Non-Sidereal Calibrators: Display non-sidereal sources from the catalogue.

• Select As...: Use the selected calibrator for one or more calibration types (amplitude, phase, pointing,
polarization, focus, or bandpass). The button will display a window to make the selection for calibration
purpose and the spectral specification.

• Close: Close the tool.

3.2 LO Configuration Tool

The tool allows the user to experiment with baseband and local oscillator setups, independently of the OT
spectral setups. It acts as a user interface to the LO solutions software that is used to calculate the LO setups
in the spectral setup of an SB.

3.2.1 Hardware Info

This panel provides information about each band, including the frequencies covered and the type of receiver
(SSB, 2SB or DSB).
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Figure 3.2: The LO Configuration Tool.

3.2.2 Settings

This panel allows you to enter the desired baseband frequencies. Up to four can be defined or removed using the
Add and Delete buttons. Request a solution with the Calculate LOs button.

• Receiver Type: Select the desired receiver.

• Request LO1: If the check box is selected then a specific LO1 may be entered.

• SSB or DSB Baseband Specs: Up to 4 basebands may be added. The information that can be entered
depends on whether you have chosen a SSB/2SB or DSB receiver. These items are:

– Sideband Pref: The desired sideband. Can be: LSB, USB, Either (in which the system will make
the choice), or (if a DSB receiver has been chosen) Both. If the latter is chosen, the next three items
appear twice, once for each sideband.

– Sky Frequency: The desired sky frequency.

11



– Weight: A weighting for this side band selection to apply when calculating the LO setup. Allowed
values are 0.0, 50.0 or 100.0.

– IF Frequency: The desired frequency of the baseband within the IF.

A message panel will report errors.

3.2.3 TuningParameters

After Calculate LOs is pressed, the tool will attempt to produce the requested sky frequencies by setting the
various local oscillators. The results of this process are produced here and are for information only.

• Receiver Band: The OT notation of the receiver band that will be used.

• LS Frequency

• FLOOG Frequency: The FLOOG frequency. For experts only.

• TuneHigh:

• Weighted Error:

• Score:

• Actual LO1: The actual LO1 frequency that will be used

• LO2 Table:

– DYTO:

– FTS:

– Tune High: For experts only

– Sidebands: The side band that is used

– IF:The Intermediate Frequency

– LO2: The LO2 frequency

– Actual LSB: Actual frequency of the LSB.

– Actual USB: Actual frequency of the USB.

3.3 Calibration Time Estimate Tool

The tool allows the user to calculate the observing time required for the calibration target, based on various
parameter settings. It is assumed that the tool will be used by advanced users mainly.

The tool contains two panels, Calibration Time and Cycle Time. At the top the Calibration Type has to
be specified: the choices are Bandpass, Phase, Amplitude, Pointing, Atmospheric and Polarization. The
various fields are listed below. The meanings of these fields will be added in a future version of the Reference
Manual.

3.3.1 Calibration Time

• Source Name:

– Resolve:

– System:

– Sexagesimal display:
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– RA:
– Dec:

• Calibrator:

– Resolve:
– System:
– Sexagesimal display:
– RA:
– Dec:

• Calibrator Flux:

• Offset Angle:

• One way movement:

• Centre Frequency:

• Water Vapour:

• Desired SNR:

• Number of Antennas:

• Aperture Efficiency:

• Tsys:

• Resolution (Obs):

• Resolution (Cal):

• Calibration Time:

• Total Time:

3.3.2 Cycle Time

This panel is only shown if Phase has been chosen as the Calibration Type.

• Center Frequency:

• Wavelength:

• Wind Speed:

• Zenith Angle:

• Phase Fluctuations:

• Fluctuation Structure:

• Cycle Time: Apply the Calculate button to display the time.

3.4 ALMA Sensitivity Calculator

The ALMA Sensitivity Calculator allows you to calculate required observing times for a given sensitivity (and
vice versa) based on various criteria.
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Figure 3.3: The Calibration Time Estimate Tool.

3.4.1 Common Parameters

• Dec: Declination of the target – used for calculating the airmass.

• Polarization: How many polarizations are to be used – Dual or Single.

• Observing Frequency: The observing frequency – sets the atmospheric opacity based on the Water
Vapour Column Density.

• Bandwidth per polarization: The bandwidth over which the sensitivity is calculated. Should be 7.2 GHz
for continuum observations and the narrowest channel for spectral line.

• Water Vapour Column Density: Precipitable water vapour column density in mm. The octiles based
on many years of monitoring at the ALMA site are offered as choices. Calculator Chooses will choose
an appropriate value for the observing frequency.

• tau/Tatm: Displays the opacity and atmospheric temperature values used.

• Tsys: Displays the system temperature value used.
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Figure 3.4: The ALMA Sensitivity Calculator.

3.4.2 Individual Parameters

Each of the following parameters can be entered separately for ALMA (i.e. the main array with 50 12-m antennas),
the ALMA Compact Array (16 7-m antennas) and the Total Power Array (4 12-m antennas operating as single
dishes).

• Number of Antennas: The number of antennas defaults to the numbers expected for Cycle 0.

• Resolution: Desired angular resolution. This is a required parameter if a sensitivity in temperature units
is entered or desired. For Cycle 0, this should be set to the angular resolution of one of the two available
configurations (as displayed on the Control and Performance section of the Science Goal).

• Sensitivity (rms): Required sensitivity or that derived from the integration time if that is requested.
May be specified in flux or temperature units. Note that using the Alt key when changing the unit choice
will perform a conversion of the value. Also displayed are the equivalent values of sensitivity in the opposite
unit to that selected. Further note that changing this parameter in the calculator will also cause it to be
updated in the Control and Performance section of the Science Goal.

• Integration Time: Total integration time recommended. May be specified in order to derive an estimated
sensitivity.

3.4.3 Buttons

• Calculate Integration Time: Calculate total observing time based on the system setup and the desired
sensitivity. This does not include calibration overheads - it is on-source time only.

• Calculate Sensitivity: Calculate sensitivity based on the system setup and the desired observing time.

• Close: Close the GUI.
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3.4.4 Feedback panel

Various warnings and errors are reported here.

Figure 3.5: The ALMA Spectral Line Selection Tool.

3.5 Spectral Line Selection Tool

The ALMA spectral line catalogue contains the rest frequencies of millions of spectral line transitions that can
be inspected and selected using this spectral selection tool. The tool can be launched with the buttons Select
Lines to Observe... and Select Lines to Overlay... when defining the Spectral Setup in a Science Goal
or via the button Line Catalogue within an SB.

On the left of the tool are a large number of filters that allow you to place various constraints on the spectral
line search. The lines that satisfy those constraints are shown in the main panel to the right of the filter selection
panel. If the tool has been launched from a Science Goal, lines can be selected and placed into a panel below
this. When the tool is closed these lines will be entered into the Science Goal’s spectral window table. Please
note that lines can be selected and de-selected by double clicking on them.

• Filter/Species: Text string for selecting the transitions from the Transition column in the database. A
checkbox allows you to select on the textual description of the transition. This is set by default.

• ALMA Band: A range of ALMA bands can be selected which in turn sets the sky frequency.

• Sky Frequency: The frequency range within which to search can be set here – this choice is also reflected
in the ALMA Band selector and the Min and Max fields. The latter can be used to enter very precise values.

• Sideband filter: If a line has been selected and this filtering is enabled, the list of available lines will
change to reflect what is now possible given the constraints on the positions of the sidebands. This is an
experimental and thus optional filter. The default behaviour is for this to be enabled when selecting lines
and disabled when overlaying.

• Maximum Upper-state Energy: This filter sets the maximum energy level of the upper state of the
transition and can be used to narrow the selection of lines.

• Molecule Filter/Enviroment: Narrow the candidate molecular transitions by selecting the category of
line to be shown.
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• Reset Filters: Reset the filters to the default values.

• Search Online: Use the selection criteria to do a search in the online catalogues. The online search is
only enabled when a species is selected and one ALMA Band is selected.

The list of available transitions can also be sorted by column by clicking on the column title. A double click
will cause that column to be the main sort column – an arrow will appear to signal this. Subsequent clicks will
reverse the order of sorting – the direction of the arrow will reverse. A secondary sort column can be defined by
single-clicking on a different column’s title – the order of this can also be reversed. The default sorting options
are by Rest Frequency (primary sort) and by Transition (secondary sort).
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Chapter 4

The Phase 1 Proposal Details

In these forms the user provides the basic details of an ALMA proposal (Phase 1), the most important part of
which is the Scientific and Technical Justification. These details are entered into a single editing page which is
found in the Proposal node of the Project Tree. The other part of a Phase 1 proposal is the information required
to set up the observations. This is done by creating Phase 1 Science Goals in the Planned Observing node (see
next section).

Figure 4.1: The Proposal Information Panel.

Below are the descriptions of the items in the Proposal forms editor. As well as this, the user also has to
create Science Goals, consisting of the field and spectral setup, the control parameters and the calibration setup
parameters. These are discussed in the next chapter.

4.1 Proposal Information

This contains basic information about the proposal.

• Proposal Title: A title for the proposal.

• Proposal Cycle: The current proposal cycle. This is a non-editable field and is set by the observatory.
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• Abstract: A short abstract for the proposal. There is a limit of 300 words.

• Scientific Category: A set of radio buttons for selecting the science category for the proposal. There are
currently four choices.

• Proposal Type: The type of the proposal. Currently the choices are Standard and ToO.

• Student Project: Check the box if the proposal is to be used for a PhD or another major student project.

• Continuation: Check the box if this is a continuation of a previous proposal.

• Related Proposals: Enter the names of proposals submitted to ALMA or elsewhere that are related to
this one.

• Previous Proposals: Details of any previous proposals that were submitted to ALMA.

• Recent Publications: Recent relevant publications by the project investigators, if any.

4.2 Investigators

This panel is used to add information about the proposal investigators. This information is contained within a
table that can only be populated by searching the ALMA user database. Therefore, all investigators must already
be registered with ALMA via the Science Portal (http://almascience.org). One Principal Investigator (PI)
is required and one or more Co-Investigators (CoI) may also be added.

Figure 4.2: The table of investigators in the proposal form.

The table contains a row for each investigator and includes the information contained within the User
Database. It is for information only and cannot be edited. The following details are displayed:

• Title: This indicates whether the individual is the PI or a CoI.

• Full Name: This is the full name of the investigator, as stored in the ALMA user database.

• Email: The email address of the investigator, as stored in the ALMA user database.

• Affiliation: The affiliation of the investigator, as stored in the ALMA user database.

• ALMA ID: This is the ALMA User Portal User ID of the investigator.

• Executive: This is the executive of the user that is based on their institute’s location and is used for time
charging purposes.

The buttons below the panel can be used the fill the Investigator table:

• Set PI: This button opens a window with which the ALMA User Database can be searched for the details
of the PI.

20



• Add CoI: This button opens a window with which the ALMA User Database can be searched for the
details of the CoI.

• Remove CoI: If a CoI has been selected in the table, they can be removed using this button.

• Add from Proposal...: Opens a window to select an ALMA Proposal and to use the proposal information
for feeding the table of investigators.

4.3 Science Case and Supporting Documents

In this panel the mandatory Science Case can be added to the proposal. Note that the format must be PDF,
have a maximum of five pages and include a Technical Justification.

Figure 4.3: The Science Case and Supporting Documents panel.

The buttons are:

• Attach: This will launch a file browser dialog to allow the user to choose a file to attach.

• Detach: This will remove a previously attached file from the proposal.

• View: This will ask the desktop operating system to launch a viewer to display the document. Note: this
relies on the operating system being setup correctly and an appropriate application installed.

4.4 Observatory Use Only

This section contains non-editable information that is relates to the proposal review process.
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Chapter 5

Phase 1 and Phase 2 Science Goals

With the Phase 1 and Phase 2 Science Goals the user provides parameters for pointing, spectral setup, control and
calibration. For details, see the the Observing Tool User Manual Chapter 6: The Phase I Observing Proposals
and Chapter 7: Phase 2 Science Goals. If the Science Goal node is selected, the information entered in each
node is presented together.

What follows are the descriptions of the five Science Goal nodes: General, Field Setup, Spectral Setup,
Calibration Setup and Control and Performance.

5.1 General

The General form is used to provide the title and description of the Science Goal. Both are optional.

5.2 Field Setup

In the Field Setup forms editor, the user is asked for source parameters such as name, coordinates, velocity and
proper motion. It consists of two to three panels, depending on the selected target type. Note that either one or
more Single Point Fields (can be controlled by the Add and Delete buttons) or a single Rectangular Field
can be defined.

5.2.1 Source

Figure 5.1: The Source panel in the Field Setup form of the Science Goal.

• Source Name: The source name. Clicking on Resolve will search for this source in a catalogue (either
SIMBAD or NED) and fills in the source properties if found.

• Resolve: Resolve the source properties from the catalogue server.
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• Choose a Solar System Object: Select if the source does not move with the stars. Default should be
false. Check the box to select from Name of object.

• Name of Object: The options are Mercury, Venus, Moon, Mars, Jupiter, Saturn, Uranus, Neptune,
Pluto, Sun, Ganymede, Europa, Callisto, Io, Titan, Ceres, Pallas, Juno, Vesta, Ephemeris and Unclassified.
These are mostly objects that are known to the telescope control system. For other objects, please select
Ephemeris – this will bring up a dialogue that allows you to load an ephemeris file.

• Source Coordinates: The coordinates of the source are entered using several fields. The values may be
filled in automatically if you have “resolved” your source.

– System: The coordinate system i.e. J2000. Changing this after values have been entered will not
cause any conversion to take place!

– Sexagesimal display: Choose whether to view your coordinates in sexagesimal format or in degrees.

– RA: Source coordinate (Right Ascension).

– DEC: Source coordinate (Declination).

– Parallax: Parallax of the source. Typically used for optical pointing.

– PM RA: Proper motion in Right Ascension; typical units are milliarcsec/yr.

– PM DEC: Proper motion in declination; typical units are milliarcsec/yr.

• Source Velocity: The velocity of the source, including the units and reference frame. Alternatively, it is
possible to enter the redshift and doppler shift type (radio, optical or relativistic) measurement. Entering
the velocity parameters provides feedback on the redshift and vica versa.

• Target Type: The supported observing patterns. Multiple single point fields or 1 rectangular field can
be defined. If a Science Goal contains multiple sources, it is only possible to define single point fields.

It is possible to enter the details of multiple sources from an ASCII disk file using the Load from File...
button at the bottom of the Field Setup form. We provide here a template for such a file that contains the
format and the allowed fields (and their units). Parameters must be comma separated.

Source Name, RA(sexagesimal) , Dec(sexagesimal), PMRA (mas/yr), PMDec(mas/yr),
Velocity (km/s), velocity reference frame, peak flux density (mJy), expected linewidth (kHz),
expected polarization (%)
-- This line signals end of the header
ngc253, 00:47:33.129, -25:17:17.808, 0.0, 0.0, 244.0, lsrk, 200, 12.5, 15
ngc1068, 23:59:59.266, -00:02:02.774, 0.0, 0.0, 1133.0, hel, 1100.0, 50, 0

5.2.2 Expected Source Properties (for Technical Assessment)

This panel provides information on the science targets that will be useful for the technical assessment of the
proposal.

• Peak Flux Density per Beam: The expected peak flux density one hopes to detect, in units of flux
density per beam, of your continuum source or spectral line. In order to validate, this field must be
completed.

• Polarisation Percentage: The expected degree of polarisation for the source. This is an optional pa-
rameter.

• Line Width: The expected line width for the lines in this Science Goal. This is an optional parameter.
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Figure 5.2: The Field Center Coordinates panel in the Field Setup form of the Science Goal.

5.2.3 Field Center Coordinates

This panel is only visible if Multiple single point fields is selected in the Source panel.

• PointingPattern: Selects whether the position of each pointing is given in absolute or relative units.
Selecting Offset will choose relative units.

• Offset Unit: If relative units have been chosen, select the units for the offset.

• RA: Right Ascension coordinate of each pointing position in either absolute or relative units.

• DEC: Declination coordinate of each pointing position in either absolute or relative units.

5.2.4 Rectangle

This panel is only visible when 1 rectangular field is selected in the Source panel. This allows a rectangle
to be defined that will subsequently be used to form a grid of pointing positions i.e. a mosaic.

Figure 5.3: The Rectangle panel in the the Field Setup form for the Science Goal.

• Coords Type: Choose between absolute or relative coordinates. This changes the interface that follows.

• Field Center Coordinates (Absolute)

– System: Coordinate System.

– Sexagesimal display: Used to switch between sexagesimal format or degrees.

– RA: The centre coordinate (Right Ascension) of the rectangle.

– DEC: The centre coordinate (Declination) of the rectangle.

• Field Center Coordinates (Relative)
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– Offset(Longitude): Longitude offset of the center of the rectangle from the source coordinate.

– Offset(latitude): Latitude offset of the center of the rectangle from the source coordinate

• p length: Length of one side of the rectangle.

• q length: Length of the other side of the rectangle.

• Position Angle: Position angle of the long side of rectangle.

• Spacing: Spacing of each pointing within the rectangle. Can be specified in various angular units or in
fraction of antenna primary beam. This parameter defaults to one half the width of the primary beam
(Nyquist sampling).

5.3 Spectral Setup

The Spectral Setup forms editor contains fields to specify spectral setup parameters. It consists of two panels
for the spectral specification and a feedback area that gives messages when the spectral specs are in error.

5.3.1 Spectral Type

Figure 5.4: The Spectral Type panel in the Science Goal’s Spectral Setup.

• Spectral Type: Choices are: Up to 4 spectral windows or Single continuum. More than 4 spectral
windows and Spectral Scan are not offered for Cycle 0. The display in the next panel is configured de-
pending on the selected option. When selecting Up to 4 spectral windows a table to contain the spectral
windows is displayed.

• Polarization: Options are : SINGLE-X or DUAL (XX and YY). DUAL should usually be chosen.

5.3.2 Spectral Elements

If Up to 4 spectral windows has been selected, a table appears which is used to enter the specifications of
each spectral window. Lines are added or removed using the following:

• Select Lines to Observe...: This opens the Spectral Line Selection Tool which interfaces to the Splata-
logue. Lines chosen here will be added to the table.

• Add: This adds a blank row to the table. The parameters must be added manually.

• Delete: This will delete the selected row from the table.

Once a row has been added to the table, the following parameters are shown and can, in most cases, be
edited:

• Center Freq Rest: The centre rest frequency of the spectral window.
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Figure 5.5: The Spectral Elements panel in the Science Goal Spectral Setup.

• Center Freq Sky: The centre sky frequency of the spectral window. This is not editable.

• Transition: A standard name for a spectral line transition, e.g. CO (1-0). This is usually filled in if a line
has been chosen using the Spectral Line Selection Tool.

• Bandwidth, Channel Spacing: The bandwidth and channel spacing of the spectral window. The
available choices are constrained to take specific values reflecting the hardware restrictions. Please note
that the channel spacing is not the same as the spectral resolution. The latter (which can be thought of as
the observed width of a spectral line with intrinsic zero width) is a function of the weighting scheme used in
the correlator and, for the default choice of Hanning smoothing, is equal to twice the channel spacing. The
choice of smoothing cannot currently be set at Phase 1. Finally, note that the maximum usable bandwidth
is actually 1.8 GHz. Therefore, for those modes that are wider than this, the edge channels will need to be
flagged.

• Process As Continuum: Check the box if this spectral window is intended to provide a measurement of
a source’s continuum.

More than 4 spectral windows is not available at Cycle 0.

5.3.3 Single Continuum

If Single continuum has been selected, you are prompted to enter a single frequency. This is actually the
average frequency of the observed data and so for ALMA bands that provide two sidebands (3, 6 and 7 for
Cycle 0), this particular frequency is not included in your data. The Spectral Visual Editor gives a graphical
illustration of this.

Figure 5.6: The Single Continuum panel in the Science Goal’s Spectral Setup.

• Input Frequency Type: Specify whether you wish to enter the continuum frequency in the rest-frame
of the source or in the sky (observed) frame.

• Rest Frequency: Average rest frequency. The corresponding sky frequency is also shown.

• Sky Frequency: Average sky frequency. The corresponding rest frequency is also shown.

5.3.4 Spectral Scan

This option is not available for Cycle 0.
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Figure 5.7: The Science Goal Calibration Setup forms editor.

5.4 Calibration Setup

In this form the user can specify how to calibrate the Science Goal. The Goal Calibrators panel offers the
following choices:

• System-defined calibration: The system will decide on the calibrators and the calibration strategy.

• User-defined calibration: When checked, this allows you to define calibration sources, either with a
dynamic or a fixed selection. A calibration table appears that displays the default calibrations. These can
be manipulated with the following buttons:

– Add Dynamic Calibrator...: After choosing the type of calibrator, the Calibrator Query Editor is
started. With this you are able to define search criteria that will be used at the time of observation
to choose the most suitable calibrator. See 3.1.

– Add Fixed Calibrator...: After choosing the type of calibrator, the Calibration Source Editor will
appear. This allows you to choose specific calibrators from the ALMA Catalogue.

– Delete Selected Calibration: Delete a selected row in the calibration table.

Note that you are STRONGLY advised to select system-defined calibration! Please note that even with
user-defined calibration, the calibration strategy cannot be set – this will be decided by the observatory.

5.5 Control and Performance

This page is for specifying the basic scientific requirements of the proposal which are subsequently used to set
the technical setup of the observations.

• Representative Frequency: The frequency to be used when considering the performance goals identified
for this Science Goal. It can be set manually, but otherwise is set to the centre frequency of the first spectral
window, or the average continuum frequency.

• Antenna Beamsize (λ/D): Display of the primary beam size for each antenna. This depends on the
Representative Frequency. This field is for feedback only.
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Figure 5.8: The Science Goal Control and Performance Parameters

• Extended Config: Max Baseline (L) and its Beamsize (λ/L): The maximum baseline (400 m) and
synthesised beam corresponding to the Early Science extended configuration. These fields are for feedback
only.

• Compact Config: Max Baseline (L) and its Beamsize (λ/L): The maximum baseline (125 m) and
synthesised beam corresponding to the Early Science compact configuration. These fields are for feedback
only.

• Desired Angular Resolution: The desired angular resolution for this Science Goal, at the Representative
Frequency specified. For Cycle 0, this should be set to the angular resolution of one of the two available
configurations as given above.

• Largest Angular Scale of Source: The largest source structure it is desired to image at the Represen-
tative Frequency. Enter an angular size if the source is extended; otherwise choose “Point Source”.

• Desired Sensitivity per Pointing: The sensitivity aim of this science goal, at the Representative
Frequency. Note that this parameter will be updated if it is changed in the Sensitivity Calculator.

• Bandwidth used for Sensitivity: Specify the bandwidth that should be used with the specified sen-
sitivity goal. The options are Aggregate Bandwidth (sum of the bandwidths of each spectral window),
LargestWindowBandwidth, FinestResolution (the smallest channel separation in your spectral setup), or
User (specify the desired bandwidth using Frequency Width).

• Does your setup need more time than is indicated by the time estimate?: If your Science Goal
is likely to need more time than the OT’s estimate, usually for (u, v) coverage reasons, please check Yes.
This choice should be explained in your Technical Justification.

• Is this observing time contrained? Check box for time-constrained observations. Yes will enable
fields for the start and end times in UTC (ISO format). A calendar tool is available for selecting the date.
Allowed Margin gives the tolerance on the entered dates and times.

• ACA Use : The ACA is not available for Early Science.
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Chapter 6

Phase 2 Program Scheduling Blocks

Planning of an Observing Program can be done in great detail by defining the Phase 2 Observing Unit Sets and
Scheduling Blocks. Comprehensive information how to do this can be found in the OT User Manual Chapter 8:
Phase 2 Program Scheduling Blocks.

6.1 Observing Unit Set

The Observing Unit Set contains one or more Scheduling Blocks and defines the relationships between these SBs.

6.1.1 Basics

The Basics panel contains very basic none-technical information only.

Figure 6.1: The Basics panel of Observing Unit Set form

• ObsUnitSet Name: A user entered name for this OUS - to be used for mnemonic purposes.

• Status: This item should probably be removed; it is intended that mutable information, in particular the
status of various pieces of the Observing Project, be maintained in the independent scheduling/project
status tree.

• Description: Optional description of the Observing Unit Set

• Launch Editor: Enable a special window of editing the Description.

6.1.2 Control

The Control panel provides the execution control limits for the OUS, in terms of items like the maximum time
allowed, the user and TAC priorities etc.
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Figure 6.2: The Control panel of Observing Unit Set form

• Maximum Time: This is the sum of allowed execution times for all parts of this OUS. It will accumulate
the maximum times of all other OUSs and SBs below it in the hierarchy.

• Execution Time: This is the estimated actual execution time as calculated by the OT.

• Array Type: The array configuration to be used. Options are the 12-m Array, the ACA, the 7-m Array
and the Total Power Array.

The following fields are currently not used:

• User Priority: This is assigned by the user to this OUS. It should perhaps be associated only with Schedul-
ing Blocks rather than with (additionally) OUS, but applying to the latter might provide a convenience
for recursion.

• TAC Priority: Priority of this observing unit as set by the TAC. Perhaps should only apply to SBs, but
at the OUS level might provide a convenient mechanism for recursion.

• Pointing Accuracy: The desired pointing accuracy as the outcome of this calibration.

• Bandpass Accuracy: The bandpass calibration must be accurate to this level - deviation from the mean,
expressed as a fraction.

• Polarization Accuracy: Polarisation must be calibrated to this level - probably expressed as a fraction.

The following three Unit Dependencies, ObsUnitSet, Data Processing panels are currently not used.

6.2 The Scheduling Block

The Scheduling Block are the key executable units of a project and contains all information necessary to execute
a single observation. In addition to the SB overview form itself, SB target details are stored in Field Sources,
Instrument Setup and Observing Parameters forms.

Note that the panels Unit Dependencies and Temporal Constraints in the SB form are currently not used and
the fields in these panels are not listed below.

6.2.1 Basic

• SchedBlock Name: A user entered name for this SB - to be used for mnemonic purposes.

• Status: This item should probably be removed; it is intended that mutable information, in particular the
status of various pieces of the Observing Project, be maintained in the independent scheduling/project
status tree.

• Description: Optional description of the SchedBlock.

• Launch Editor: Enable a special window of editing the Description.
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Figure 6.3: The Basics panel of the Scheduling Block form

6.2.2 Control

The Control panel provides the execution control limits, in terms of items like the maximum time allowed, the
user and TAC priorities etc.

Figure 6.4: The Control panel of the Scheduling Block form

• Maximum Time: This is the sum of allowed execution times for all parts of this SchedBlock. This will
be = repeatCount*SBMaximumTime;

• Execution Time: This is the estimated actual execution time as calculated by the OT.

• Array Type: The array configuration to be used. Options are the 12-m Array, the ACA, the 7-m Array
and the Total Power Array.

In the next subpanel the following fields are currently not used:

• User Priority: This is assigned by the user to this SchedBlock. Perhaps it should be associated only
with Scheduling Blocks rather than with (additionally) OUS, but applying to the latter might provide a
convenience for recursion.

• TAC Priority: Priority of this SB as set by the TAC. Perhaps should only apply to SBs, but at the OUS
level might provide a convenient mechanism for recursion.

• Pointing Accuracy:The desired pointing accuracy as the outcome of this calibration.

• Bandpass Accuracy: The bandpass calibration must be to this level - deviation from the mean, expressed
as a fraction.
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• Polarization Accuracy:Polarisation must be calibrated to this level - probably expressed as a fraction.

6.2.3 Unit Dependencies

Currently not used.

6.2.4 Preconditions

The Preconditions panel specifies the conditions that must be met before this SchedBlock can be executed.

Figure 6.5: The Preconditions panel of the Scheduling Block form
.

• Baseline cal: If true, baseline calibration must have been done before this SB is executed.

• Max PWVC: Maximum value of precipitable water vapour column density in mm. If the current value
exceeds this, the SB should not be executed.

• Seeing: The user will want to input this in arc seconds. This should be the raw value (i.e., before
correction).

• Phase Stability: RMS of astronomical phase after WVR correction over some TBD time period (hopefully
>= length of an SB), expressed in degrees.

• Max Wind Velocity: Maximum allowed wind velocity for this SB.

• Min Allowed HA: SB must be scheduled at HA greater than this maximum.

• Max Allowed HA: SB must be scheduled at HA less than this minimum.

6.2.5 SchedBlock

• Standard Mode: Checkbox. If true, this SchedBlock is part of a supported, “standard ALMA observing
mode”, such as single-field interferometry or interferometric mosaicing. This field will be set to false by the
Observing Tool should a user intervene directly in the OUS/SB hierarchy, rather than relying on the OT’s
generated values that are derived from his/her scientific input.

• Mode Name: The name of the (presumably standard) observing mode, e.g., SingleFieldinterferometry,
OpticalPointing.
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Figure 6.6: The SchedBlock panel of the Scheduling Block form

• Mode Type: The type of the observing mode: either a Standard mode, User or Observatory, or a non-
standard Expert mode.

• Execution Count: The number of times to execute this SB. (I.e., execution count = 0 –> SB will never
be run and is an invalid value).

• Max. Time: Maximum time for a single execution of this SB.

• Obs. Procedure: The script (written in Python) that contains the observation logic to be executed
by the Control subsystem for this Scheduling Block. For standard observing modes, this script will be
obtained from a configuration-controlled library that is managed by the ALMA observatory. At execution
time, all parameters contained in the Scheduling Block will be made available to this script.

• Run Quick Look: Checkbox. Indicates whether or not the Quick Look should execute on completion of
this SB. For most science uses this will be true, but for some engineering or calibration SBs it may be false.
In general the value should be determined by the observing mode with rare need for user-override.

6.2.6 Advanced Parameters

The Advanced Parameters panel allows the specification of advanced parameters that will be passed to the
observing script. The keyword-value parameters allowed are free-form, but must match what is expected in the
script. They are for the use of advanced (ALMA Staff) users only.

Figure 6.7: The Advanced Parameters panel

35



6.2.7 Performance Goals and Scheduling Constraints

The Performance Parameters panel define the science performance required for this SB.

Figure 6.8: The Performance panel of the Scheduling Block form

• Representative Target: The representative target, to be used partly for more information about the
required observing conditions, but mostly to indicate which target to measure the observing goals against.

• Representative Coordinates: The representative coordinate for this SB. Usually obtained from the
representative target, but may be derived by some other algorithm for some types of SB. Systems gives a
drop down menu to specify the coordinate system. Sexagesimal display is to specify the notation format.

• Representative Frequency: The frequency to be used when considering (setting up for or measuring)
the performance goals identified for this science goal.

• Representative Receiver Band: Representative receiver band for this SB execution.

• Min. Angular Resolution: This parameter, its twin, "Max Angular Resolution," and the Representative
Frequency are used by the Scheduler to determine whether the current antenna configuration is suitable to
achieve the angular resolution desired by the PI.

• Max. Angular Resolution: see above.

• Dynamic Range: This is the ratio of maximum flux expected to rms level desired; it may apply either
to a particular spectral window or as a minimum goal for all windows. It affects the uv-coverage necessary
as well, and hence is needed by the Scheduler.

6.2.8 Temporal Constraints

Currently not used.

6.3 Observing Groups

Each target (see below) must be placed into an observing group for it to be observed. (There are exceptions
for certain observatory calibration modes). Groups are added from the Edit menu, and targets are allocated to
groups in the editor for the Observing Group.
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6.4 Targets

For each target the Resources are to be defined: Field Source, Instrument Setup, Observing Parameters. These
details are stored in the corresponding subfolders in the Resource folder. Combining these details reveals the
complete target description that are visible with clicking on the targets in SB Target folder. A table overview of
the targets is displayed when selecting the SB Targets node in the Project Tree.

Below the details of the Field Sources, Instrument Setup, Observing Parameters forms are provided.

6.5 Resources

6.5.1 Field Sources

A table overview of the Field Sources is displayed when selecting the SB Field Source node in the Project Tree.
The following panels are visible for each Field Source entry

Field Source

Figure 6.9: The Field Source Panel of the Scheduling Block Field Sources Form
.

• Field Source Name: A user-settable name for the Field Source - allows the user to identify a particular
setup. This name can be different from the source name, e.g. "NGC1068 nucleus".

• Source Name: The source name. Typically obtained from a catalogue.

• Coose a Solar System Object: Check if source is solar system object. The drop down list contains known
(to the control system) solar system objects. "Ephemeris" is a special choice, for which the "ephemeris"
attribute should be completed.

• Source Coordinates: The coordinates of the source. This item includes

– System to specific the coordinates system
– Sexagesimal display for the format.
– Parallax: Parallax angle for the source.
– RA and Dec. Typically might be obtained from a catalogue.
– Proper Motion RA: Proper motion in right ascension; typical units are milliarcsec/yr. Might be

obtained from catalogue.
– Proper Motion Dec: Proper motion in declination; typical units are milliarcsec/yr. Might be

obtained from catalogue.
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• Source Radial Velocity: The velocity of the source, including reference frame, optical or radio measure-
ment and the redshift. It is also possible to enter a redshift. Might be picked up from catalogue.

In the source properties table that follows, flux and diameter, together with the frequency can be provided.

Finally:

• Visible Magnitude: Visible magnitude for the source (used in optical pointing). Is this definitely
used/required? If so, can we specify it a little better?

• Use Reference: Use this position as a reference for off-source single dish observation.

Reference Position

Up to two reference positions are allowed.

Figure 6.10: The Reference Position, Field Pattern panel of the Scheduling Block Field Source Form

• Coords Type: Field center(s) in absolute or relative coordinates. In case Absolute is selected the
specifications for the field center need to be provided. In case Relative the offset from the source coordinate
shall be provided.

• Reference Coodinates: Coordinate System (ABSOLUTE only).

• RA: Absolute field center coordinate (RA) (ABSOLUTE only).

• DEC: Absolute field center coordinate (Dec) (ABSOLUTE only).

• Offset[RA]: RA offset from the source coordinate (RELATIVE only).

• Offset[DEC]: DEC offset from the source coordinate (RELATIVE only).

• Integration Time: This is the time spent off-source in a single dish observation.

• Cycle Time: This is the period between visits to the reference position.

• Sub Scan Duration: The number of seconds the subscan will take. This value must be an multiple of
the integration duration.

• Adjust subscan duration to a correct value: Adjust the sub scan duration to fulfill thr requirements.
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Figure 6.11: The Reference Position, Field Pattern panel of the Scheduling Block Field Source Form

FieldPatternEditor

In the Field Pattern panel the field pattern can be defined. The choice of the field pattern determines the name
and the fields in the next panel in which the properties of the field pattern are to be defined.

At the top the primary beamsizes at 230 GHz for the 12-m and 7-m are displayed.

• Type: The pattern to be used in observing the target, be it scientific or calibration. Supported are point,
rectangle, and cross.

Field Pattern

Below follows the field and the description of the various field patterns:

• For Point:

Figure 6.12: The field pattern point panel for the Scheduling Block Field Source Form

– PointingPattern: Offset: Tick if the pointing pattern position is an offset w.r.t. the source. If not
ticked absolute positions are provided.

– Offset Unit (Type=point): Units of the offset (only if Offset is ticked).

• For rectangle:

Figure 6.13: The field pattern rectangle panel for the Scheduling Block Field Source Form
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– Coords Type: Field center in absolute or relative coordinates. In case Absolute is selected the
specifications for the field center need to be provided. In case Relative the offset from the source
coordinated shall be provided.

– Pattern Center Coords

∗ System: Coordinate System (ABSOLUTE only).
∗ RA: Absolute field center coordinate(RA) (ABSOLUTE only).
∗ DEC: Absolute field center coordinate(Dec) (ABSOLUTE only).
∗ Offset[RA]: RA offset from the source coordinate (RELATIVE only).
∗ Offset[DEC]: DEC offset from the source coordinate (RELATIVE only).

– Lat. length: Length of the rectangle in the latitudinal coordinate.

– Orthogonal step: Step size in the direction orthogonal to the scan direction.

– Long. length: Length of the rectangle in the longitudinal coordinate.

– Scan Direction: The scanning direction for the raster, either in longitude or latitude.

– Unidirectional Scan: Check if the scan shall always be done is the same direction.

– Scan Velocity: The scan velocity.

– Orientation: Position angle of the rectangle in the scanning coordinate frame. (Zero point and
direction need to be agreed with control).

– Scanning Coordinate System: Select the coodinate system.

– Setup Mosaic (Optional): Convert the setup top a pointed mosaic.

• For Cross:

Figure 6.14: The field pattern cross panel for the Scheduling Block Field Source Form

– Pattern Center Coords

∗ System: Coordinate System (ABSOLUTE only).
∗ RA: Absolute field center coordinate(RA) (ABSOLUTE only).
∗ DEC: Absolute field center coordinate(Dec) (ABSOLUTE only).
∗ Offset[RA]: RA offset from the source coordinate (RELATIVE only).
∗ Offset[DEC]: DEC offset from the source coordinate (RELATIVE only).

– Lat. length: Length of the cross in the latitudinal coordinate.

– Long. length: The length of the cross in the longitudinal direction.

– Initial Scan direction: The initial scan direction for the cross.

– Scan Velocity: The scan velocity.

– Orientation: Position angle of the cross. NOTE: Zero point and direction need to be agreed with
Control.
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6.5.2 Instrument Setup

When clicking the Instrumental Setup node in the Resources folder of the SB, a summary table becomes visible
with Instrument Setups that have been specified.

Below follows the complete list of all fields in the Instrument Setup form for the a SB and their meaning.

6.5.3 Spectral Spec

Figure 6.15: The Spectral Spec panel in the SpectralSpec form of the Instrument Setup

• Spectral Spec Name: A user-settable name for the Spectral Spec - allows the user to identify a particular
setup. Not meant to be used by any subsystem other than Observing Tool.

• Rest Frequency: Rest frequency of the line to be observed.

• Transition: Molecule and transition.

• Line Catalogue: Button to start the Spectral Line Selection tool.

• Receiver Band: One of the 10 receiver bands foreseen for ALMA.

• Receiver Type: The type of receiver. This should be set automatically, once the receiver band is known.
It is one of no sideband (NSB), single sideband (SSB), two sideband (2SB), or dual sideband (DSB).

• Add Total Power with square law detector to this correlator setup: Check if in addition to the
selected receiver the total power detector with square law detector option shall be used. This option is not
implemented yet.

6.5.4 Switching

This functionality is not implemented yet and consequently the panel is disabled

6.5.5 Correlator Configuration

Figure 6.16: The Correlator Configuration panel for the ALMA BL in the SpectralSpec form of the Instrument
Setup. The panel for the ACA correlation looks very similar
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• Integration Duration: The integration duration must be a multiple of the dump duration. The Inte-
gration Duration is the lenght of time to spend accumulating dumps in the CDP as spectral data blocks.
Reasons for preferring shorter integrations include 1) source strong enough to allow self-cal; 2) rapidly
varying phase; 3) observations requiring high time resolution (e.g., solar, flare starts[?]); 4) OTF mosaics.
The more channels you use, the longer the minimum integration must be, because the time required to
read out the maximum number of channels (8192) is 512 ms. UV smearing effects need to be considered
at longer baselines.

• Adjust: Button to force the integration duration to be a multiple of the channel average duration.

• Channel Average Duration: Also known as sub-integration. The duration of the channel averaging is
between 0.5 and 1.024 seconds, such that the smallest number of channel average durations fits into the
spectral integration duration. For values < 500 msec there will be no channel averages calculated.

• Adjust: Button to force the channel duration to be a multiple of the channel dump duration.

• Atmos. Phase Correction Data To Save: Drop down list to determine which Atmospheric Phase
corrected data is to be sent: Corrected, uncorrected, both, or mixed.

• Accumulation Mode: Correlator accumulation mode can be ALMA_FAST (1 msec) or
ALMA_NORMAL (16 msec) which defines the correlator chip level accumulation duration. Note that
this must be ALMA_NORMAL for cross-correlations, and this is therefore the default chosen. For
ALMA_FAST only auto-correlation products are sent to the CDP. For ALMA_NORMAL, then both
auto- and cross-correlation products are sent to the CDP.

• LO Offsetting Mode: Drop down list for selection the LO Offsetting.

• Enable 90deg Walsh function: Enable 90 deg Walsh function.

• Enable 180deg Walsh function: Enable 180 deg Walsh function.

The following field is visible for a spectral specification with the Baseline correlator.

• Dump Duration: The dump interval must be a multiple of 16 msec (if accumulation mode is ALMA_NORMAL)
or 1 msec (for accumulation mode ALMA_FAST).

6.5.6 BaseBand Configuration

LO Setup Preferences

Figure 6.17: The LO Setup Preferences panel for the ALMA BL in the SpectralSpec form of the Instrument
Setup. The bottom part of the figure shows the overview table of the specified basebands

• Sideband(s) to prioritise: The check boxes for "Sideband(s) to prioritise" provide the possibility to
select the side bands to be prioritised in the calculation of the LO setup. Pressing the GO button will
calculate the LO setup according to the parameters set by the check boxes.
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• Base band config(s) to prioritise: The check boxes "Baseband config(s) to prioritise" provide the
possibility to select the baseband configs to be prioritised in the calculation of the LO setup. Pressing the
GO button will calculate the LO setup according to the parameters set by the check boxes.

• Calculate LOs: Calculate the LO setup based on the preference set and the source velocity.

• LO1 Frequency: The LO1 frequency as determined in the OT, either by the tool itself, or entered by the
user. This is an estimate used to help the user in correlator setup - the actual value used will depend on
the time of observation.

• Total Data Rate: Estimate of the total instantaneous data rate summed over all basebands and based
on the current parameter settings.

BaseBand Configuration Forms

A Baseband Configuration summary table (see Fig 6.18) is visible above the baseband specification forms. Apart
from a few fields the table also shows the LO2 frequency and the instantaneous date rates that can be expected
for each baseband configuration. Note that the LO2 frequency is determined within the OT, by the tool itself.
This is an estimate to help the user in preparing a correlator setup - the actual LO2 used may vary depending
on the time of observation, and is set by Control at execution time. for specifying the maximal four basebands.

Figure 6.18: The BaseBand tabd for the ALMA BL in the SpectralSpec form of the Instrument Setup. The
bottom part of the figure shows the overview table of the specified spectral windows

• Baseband Name: Set automatically, one of BB_1, BB_2, BB_3 or BB_4.

• Desired Center Frequency: The desired centre frequency (in sky units) for this BBC. Not needed for
the Correlator Config, rather this is maintained as the users desire for the location of this BBC, and thus
to calculate the LOs.

• Actual Center Frequency (Rest): The actual centre frequency (in rest units) for this BBC.

• Actual Center Frequency (Sky): The actual centre frequency (in sky units) for this BBC.

• Products: Allows the user to select both auto and cross correlation products or auto only or cross only.
When the accumulation mode is ALMA_FAST, only the auto products are available. The default is
CROSS_AND_AUTO.

• LO2 Frequency Switching: Check if frequency switching is to be performed at LO2. This will always
be false unless FREQUENCY_SWITCHING is selected at the SpectralSpec level.

• Number of Positions: The number of switching positions in the switching setup, 1 (which is no switch-
ing), 2, 3,or 4.
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• Dwell Time: Part of the setup for the "switching" definition. The dwell time is the data collecting
duration at a given position. dwell time + dead time must be a multiple of 48 msecs. Dwell time is ignored
if there is no switching (TBC).

Spectral Window Tabs

A Spectral Window summary table is visible above the spectral window specification tabs. Apart from a few
fields the table also shows the data rates and the sky frequency that can be expected for each spectral window.

Figure 6.19: The Spectral Window forms to provide the Spectral Windows specifications.

• SpectralWindow Name: A locally unique name for this spectral window, Automatically set.

• Center Offset Frequency: The center frequency of the spectral window, between 2000 and 4000 MHz.
This value is an offset into the 2GHz bandwidth of the baseband. Can only take discrete values, determined
by the step size of the band, i.e. 2GHz/8192 = 244.141 kHz.

• Center Freq(Rest) LSB/USB: The center rest frequency for the LSB and USB.

• Center Freq(Sky LSB/USB: The center sky frequency for the LSB and USB.

• Use LSB - Use USB: Check when using LSB, USB, DSB or NOSB. Note that if this spectral window is
LSB, then its frequency (or channel) order is reversed from the sky frequency, i.e., lowest sky frequency is
highest baseband frequency. The sideBand mode should be common to all spectral windows in a baseband
for SSB receivers.

• Nominal BW # Channels: The nominal bandwidth and number of channels of the spectral window.

• Effective BW # Channels: The effective bandwidth of the spectral window and the effective number
of channels in the spectral window. The effective number of channels is same as the nominal one for ACA
correlator, and by 1/16 less than the nominal one for BL correlator.

• Resolution: The spectral resolution.

• CorrConfigMode/Filtermode: Correlator configuration internal mode number and filter type.

• Polarization Products: Options: XX, YY (single pol’n) or XX,YY, (dual pol’n) or XX, YY, XY, YX
(full pol’n). The ACA correlator always outputs all 4 polarization products. The ACA correlator will share
the setup if it is common to all spectral windows in a baseband. For the ACA correlator, the polarization
products can not be changed by the spectral windows.

• Averaging Factor: Specifies the number of spectral channels to average together for each subband. This
factor is the number of adjacent channels to average together and must be a power of 2, e.g., 1, 2, 4, 8, etc.
The spectral averaging factor can be used to reduce the amount of spectral data sent to the Archive.
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• Window Smoothing Function: An enumerated value representing the data smoothing function to use.
One of: UNIFORM, HANNING, HAMMING, BARTLETT, BLACKMANN, BLACKMANN_HARRIS,
WELCH.

The following BL Only subpanel applies to the Baseline Correlator Setup only:

• Correlation Bits: The correlation bits settings for the baseline correlator. Options are: 2x2, 3x3, 4x4.
Higher numbers will increase the sensitivity but requires more resources.

• Oversampling: Nyquist sampling/oversampling. True means do Nyquist oversampling, False means non-
oversampling.

• Quantization Correction: Boolean selection to perform quantization (’VanVleck’) correction on the
lag data. Normally this is true, but for diagnostic purposes, we may wish to view the uncorrected lags.
The ACA correlator does not use this parameter, because the ACA-CDP always does the quantization
correction on the spectral results.

On the right side the Spectral Average Region table is visible that can be used to specify the spectral bands
that are to be averaged. The user can select up to 10 sets of contiguous channels (a ChannelAverageRegion)
which contribute to the channel average result. Note that these parameters are based on effective channels. That
is, Start Channel must be a zero based index within the effective range of spectral channels and the number of
channels is interpreted based on the spectral resolution (band-width per channel) before any spectral averaging
(spectralAveragingFactor) has been applied.

• Start Channel: Starting (0-based) channel used to calculate the spectral channel average for a given
region. This should be an unsigned type.

• Num. Channels: Number of spectral channels used to calculate the spectral channel average for the
region. This should be a positive integer.

6.5.7 Observing Parameters

The Observing Parameters node provides the intent of the observations More than one may be associated with
a single target. There are Science Parameters which provide scientific intent of a target and several types
of Calibration Parameters, providing a calibration intent. A number of calibration parameters sets (e.g. for
Holography and Radiometric and Optical Pointing) are intended to provide the intent for a Scheduling Block,
instead of a target.

Selecting the Observing Parameters node given the overview table of all Observing Parameter types that have
been defined. Below follows the descriptions for the fields in the various tabs.

Science Parameters

The Science Parameters have the following items:

• Science Parameters name: A user settable name, to be used as a mnemonic.

• Representative Bandwidth: This is the representative bandwidth for this Science Goal, Note that the
sensitivity is a function of bandwidth.

• Representative Frequency: This is the representative frequency to use. Note that the sensitivity is a
function of frequency.

• Sensitivity Goal: The rms sensitivity in Jy or mJy desired for the target when observed at the Repre-
sentative Frequency with the Representative Bandwidth. This allows specification for either continuum or
spectral line observations. It is possible to keep track in near-real-time of the sensitivity already reached.
The estimate can improve on that supplied by the OT’s ETC because it can access the actual system
temperatures.
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Figure 6.20: The Observing Parameters form to provide the parameters for the targets in the SB. The Science
parameters tab is visble.

• Integration Time on source: Desired integration time for this source in this SB.

• Sub Scan Duration: The subscan duration must be a multiple of the integration duration. This is the
number of seconds the subscan will last. When this duration ends, data stops flowing from the CDP.

• Adjust subscan duration to a correct value: Ensure that the subscan duration is a multiple of the
integration duration.

There is also an Advanced Parameters panel, identical to that for the SchedBlock. Here advanced parameters
specific to the type of Observing Parameter may be inserted into the script. This is for advanced (staff) users
only.

General Calibration Parameters

The Calibration Parameters share the following items:

• Calibration Type Parameters name: A user settable name, to be used as a mnemonic.

• Cycle Time: How often this calibrator should be observed within the observing script of the SB (may be
overridden when observing).

• Default IntegrationTime:A Default integration time on this calibrator (may be overriden when observ-
ing)

• Data Origin: Data source to use when analysing results from this calibrator target when observed at the
RepresentativeFrequency with the RepresentativeBandwidth Source can be channel, average, cross of auto
correlation, wvr, etc.
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• Sub Scan Duration: The subscan duration must be a multiple of the integration duration. This is the
number of seconds the subscan will last. When this duration ends, data stops flowing from the CDP.

• Adjust subscan duration to a correct value: Ensure that the subscan duration is a multiple of the
integration duration.

In addition, the PolarizationCal Parameter has the folowing item:

• Desired Polarization accuracy: The desired calibrated accuracy resulting from this calibration.

In addition the PointingCal Parameter has the following items:

• Desired Accuracy: The desired calibrated accuracy resulting from this calibration

• Pointing Method: Method to be used for the calibration

• Maximum Elapsed Time: Maximum time allowed to achieve this accuracy.

• Excursion: Maximum outwards excursion during the calibration.

SB Calibration Parameters

The Holography Parameters has the following items:

• Frequency: Frequency to observe at

• Start Fraction: How far into the scan to begin?

• Speed: Speed to scan at

• Calibration Rows: Number of observation rows between periods spent acquiring signal calibration data

• Calibration Time: Time spent on each calibration observation

• Number of Rows: Number of rows in the scan

• Row Size: Size of each row

• Tower: name to tower to use

• Scan Direction: Which direction to scan in

• Calibration Mode: Mode to use

• uniDirectionalScan: Whether or not to always scan the same direction

The Optical Pointing Parameters has the following items:

• Antenna Position Tolerance: The acceptable position tolerance needed before observing.

• Elevation Limit: The elevation limit below which not to observe

• Max Magnitude: The max magnitude target to observe

• Min Magnitude: The Min. magnitude target to observe

• Randomize Order: Whether or not to randomize the order of observing the stars
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Chapter 7

The Visual Editors

7.1 The Visual Spatial Editor

The Visual Spatial Editor is a graphical tool that aids in the choosing of parameters for the Field Setup form in
a Science Goal, as well as in the Target section of a Scheduling Block (via the Field Source node). It is selectable
via the Spatial tab in the Editors pane. An example of the image display can be seen in Figure 7.1.

Figure 7.1: An example of the image display area of the Visual Spatial Editor. The source position is marked
with a cross and a rectangular mapping area has been defined.
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7.1.1 Tool Bar and Zooming Functions

At the top of the display a toolbar is visible. It provides the following functions:

• Open a FITS file: Display a FITS file that is stored on disk.

• Save image as...: Save the displayed image. The output format can be selected in a separate window.

• Cut selected FOVs: Delete a pointing position that has previously been selected e.g. by clicking on it in
the image or using the Select FOVs button.

• Select FOVs in a rectangular region: Multiple pointing centres can be selected by drawing a rectangular
area around them.

• Set the target center (Source Coordinates): Mark the centre of the target by clicking in the image.
This will change the source coordinates in the Source panel.

• Add a FOV: Add a pointing centre by clicking in the display. These will be added to the tablel in the
Field Centre Coordinates panel.

• Draw a rectangular map: Use the cursor to define a rectangular region to be mapped – this will change
the Target Type in the Source panel. Via the colour anchors the region can be reshaped and rotated. This
region will be tiled with a mosaic of pointings depending on the parameters in the Rectangle panel.

• Show Pointing Positions: Show the mosaiced pointing positions calculated for a rectangle field.

• Image Cut levels: Set the image cut level and pixel value distribution using a separate interface.

• Show/Hide Grid: Display a coordinate grid.

At the bottom of the display four buttons are available for zooming functions. In addition the zoom factor,
the pixel and sky coodinates at the cursor position and pixel value are visible. The image filename that is loaded
is also displayed.

7.1.2 FOV Parameters

Figure 7.2: The FOV and Image Servers panel that is located below the Visual Spatial Editor.

The FOV Parameter panel allows the user to manipulate the field of view of each pointing centre i.e. the size
of the circles drawn on the Visual Spatial Editor.

• Frequency used: Rest frequency used to determine the Field of View. This is usually set by the frequencies
set in the Spectral Setup node of a Science Goal, but can be changed by the user.

• Refresh: Update the frequency field.
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• (taken from): This states where the displayed frequency was taken from. It is blank if a user enters their
own value.

• Antenna Diameter: Antenna diameter that shall be used for calculation of the primary beam size (λ/D).
Choices are usually 12m (Main array) and 7m (ACA), but this option is disabled for Cycle 0.

• Main beam size: Diameter of the primary beam based on the antenna diameter and observing frequency.
This field is for information only and cannot be edited.

• Show FOV (circle): Select this if you would like the Field of View of each telescope pointing to be
displayed. This is enabled by default.

7.1.3 Image Query

The Image Query panel allows you to select the external image server from which an image of your source can
be displayed.

• Image Server: Select the image server from which the image shall be retrieved.

• Image Size (arcmin): Set the size of the image to be uploaded. Larger images take more time.

• Query: Run the query. The image will be retrieved and displayed.

7.2 The Visual Spectral Editor

The purpose of the Visual Spectral Editor is to offer a graphical presentation of the frequency setup that is
calculated based on the entered spectral window frequencies (or baseband and spectral window frequencies in
the case of a Scheduling Block).

7.2.1 Visual Spectral Editor for Science Goals

The Visual Spectral Editor for Science Goals is divided into five panels.

Visualisation

The Visualisation panel has two sets of buttons. The first, Overlays, toggles the display of various items. The
default colours of these can be changed using File → Preferences. The second, Viewport, allows the display to
be zoomed and panned.

• Overlays

– Receiver Bands: This displays the available receiver bands. The upper hatched area shows the
frequency range of the band, whilst the lower hatched area shows the allowed range of the first local
oscillator (default colour blue).

– Transmission: This displays the atmospheric transmission curve (default colour grey).
– Overlay Lines: This will toggle the display of lines that might have been overlaid using the Spectral

Lines Selection Tool.
– Select Other Lines: This will start up the Spectral Lines Selection Tool and allow spectral lines to

be overlaid (default colour green).

• Viewport

– Pan To Line: Pan to the selected frequency. For a continuum setup this is just the entered (average)
frequency. For a spectral line setup, it is the line that has been selected in the spectral window table.
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Figure 7.3: The graphical representation of the frequency information for Science Goals.

– Zoom To Band: Zoom to the centre of the current receiver band.
– Reset: Return to a completely unzoomed view of the ALMA frequency range.

Spectral Type

This panel is also included in the forms view of the Field Setup.

• Spectral Type: Type of spectral observation. The four choices are: Up to 4 spectral elements, More
than 4 spectral elements, Single continuum and Spectral scan.

• Polarization Products desired: The choices are SINGLE-X or DUAL. The default choice is DUAL. The
choice is applied to all spectral elements in the Science Goal.

Spectral Details

This panel is also included in the forms view of the Field Setup node. What is displayed depends on the choice
made in the Spectral Type panel.

• Up to 4 spectral windows: A table is displayed with the specifications of a maximum of 4 spectral
windows. By double clicking in the cells, the specifications can be changed.

• Single continuum: The following fields are displayed:

– Input Frequency Type: Specify whether you wish to enter the continuum frequency in the rest-
frame of the source or in the sky (observed) frame.

– Rest Frequency: Average rest frequency. The corresponding sky frequency is also shown.
– Sky Frequency: Average sky frequency. The corresponding rest frequency is also shown.

Spectral Setup Errors

This panel also included in the forms view of the Field Setup node. It displays errors and warnings for the
spectral specifications, if any.
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Targets

This table contains all the sources that have been defined in the Field Setup forms editor. By selecting one, the
displayed lines will move to reflect that source’s velocity. Note that LO1 and the sidebands do not presently
move – they always correspond to the first source in the list.

7.2.2 Visual Spectral Editor for Scheduling Blocks

The Visual Spectral Editor for Scheduling Blocks consists of two major panels. At the right the panel of the
Instrument Setup form is displayed

Receiver & LO Visualisation

• Basebands: Display the baseband ranges.

• Other Transitions: Toggle drawing of the other transitions that have been selected.

• BBC Centre Frequencies: Display the centre frequencies of the baseband configurations.

• Receiver Bands: Displays the available receiver bands 1 to 10.

• Side Bands: Display the LSB and USB ranges.

• Transmission: Display the atmospheric transmission curve.

• Select Other Transitions: Click to start up the Spectral Lines Selecting Tool to select lines to be
displayed.

• Pan To Line: Pan to the rest frequency.

• Zoom To Band: Zoom to the current receiver band.

• Reset: Reset the display settings.

Figure 7.4: The graphical representation of the frequency information about receivers and LO frequencies.

Baseband Visualisation

• Track Selection: Control whether or not to zoom to a newly selected baseband.

• Other Transitions: Display the nearby lines in the spectral line catalogue.

• Side Bands: Display the frontend LSB and USB frequency ranges.
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Figure 7.5: Visualisation of the a baseband configuration. Visible are part of the frequency band (hashed),
the transmission curve, four basebands and their spectral windows. For BaseBand 1 (BBC1 at 230 GHz) two
spectral windows are defined. The most optimal LO1 frequency is displayed after applying the GO button.

• Fold Basebands: Optimize the use of the vertical space for drawing the basebands.

• Fold Spectral Windows: Optimize the use of the vertical space for drawing the spectral windows.

• Receiver Band: Displays the available receiver bands 1 to 10.

• Transmission: Display the atmospheric transmission curve.

• Zoom to Receiver Band: Reset the scale to the receiver band.

• Zoom to Selected Baseband: Zoom to the selected baseband.

• Zoom to Mirror: Zoom to the mirror (in the LO1 frequency) of the current window.
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Appendix A

Acronym List

2SB: Two sideband (ALMA bands 3–8)
ACA: Atacama Compact Array
ALMA: Atacama Large Millimeter/submillimeter Array
APC: Atmospheric Phase Correction
ARC: ALMA Regional Centre
ASC: ALMA Sensitivity Calculator
ATF: Alma Test Facility
BBC: BaseBand Configuration
BL: Baseline (e.g. BL Correlator)
DBB: Database Browser
DFS Data Flow System
DSB: Double Sideband (ALMA bands 9 and 10)
FOV: Field Of View
FFT: Fast Fourier Transform
HLA: High Level Analysis
GUI: Graphical User Interface
ID: Identifier
IPT: Integrated Product Team
JDK: Java Development Kit
JRE: Java Runtime Environment
JVM: Java Virtual Machine
LO: Local Oscillator
LSB: Lower Side Band
OUS: ObsUnitSet
OT: Observing Tool
OTF: On The Fly (mapping)
PI: Principal Investigator
SB: Scheduling Block
SSB: Single Sideband (ALMA bands 1 and 2)
SSR: Science Software Requirements
SFI: Standard Field Interferometry
TAC: Time Allocation Committee
TFB: Tunable Filter Bank
VLA: Very Large Array
USB: Upper Side Band
UT: User Test
XML: Extensible Markup Language
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